
Instructions to Visualize Horse Heaven Hills Wind Farm 
 

Introduction 
When a wind farm is first proposed, the almost universal reaction by people living in the 
affected community is “What will it look like from my home?” If there is a visual impact 
assessment, it will contain photorealistic simulations from a few viewpoints selected by the 
developer’s consultants. However, these viewpoints are selected by the developer’s team and it 
is almost certain that none of them are from your home. 
 
The goal of these instructions is to get you up and running on Google Earth Pro to visualize the 
Horse Haven Hills Wind Farm from your home. One big reason to use Google Earth is that it is 
that the software is totally free and will run on any PC, Mac or Linux computer. After completing 
the steps discussed here you may want to explore the view from other locations, as well as 
other features of Google Earth Pro. 
 
You will be looking at the layout for Option 1. The only spatial information available to the 
public is a PDF of a map you can download at: 
 
https://drive.google.com/file/d/1LAztIg_vdqAmMhnNGcRN1qkIygIWcTRt/view?usp=sharing 
 
This PDF also includes the layout for Option 2 with fewer but taller turbines. We were unable to 
prepare a KMZ for this option. 
 
These instructions refer to Horse Haven Hills Wind Farm as HHH and Google Earth Pro as GEO.  
 
Step 1: Download and install Google Earth Pro 
You need to open a web browser on your PC or Mac computer and go to:  
https://www.google.com/earth/about/versions/#earth-pro 
 
Select the “Download Earth Pro on desktop” box and then follow the instructions. This process 
should be straightforward—it is just like installing any other software. It will be installed where 
ever software is normally installed. 
 
Once it is installed, you can open it by double clicking on it. GEO is a fun program. You can look a 
places all around the world, and even visit the moon and other planets. 
 
Step 2: Download the Horse Haven Hills Wind Farm KMZ 
The 3D model of HHH’s Option 1 wind turbines is called HHH_Opt_1.kmz, or KMZ for short. Click 
on this link and select Download:  
 
https://drive.google.com/file/d/14-ZGS3nRxiJMLwaDg87hW_PY_6UPS_0X/view?usp=sharing 
 

https://drive.google.com/file/d/1LAztIg_vdqAmMhnNGcRN1qkIygIWcTRt/view?usp=sharing
https://www.google.com/earth/about/versions/#earth-pro
https://drive.google.com/file/d/14-ZGS3nRxiJMLwaDg87hW_PY_6UPS_0X/view?usp=sharing


Put it away in a location that is easy for you to find on your computer—maybe create a folder 
for HHH Wind Farm on your desktop or in Documents and put it there. 
 
Step 3: Open the HHH KMZ  
Double click on the HHH_Opt_1.kmz file and it will open in GEO.  
 
There will be a floating window over the aerial map with tips about Navigating Google Earth. I 
encourage you to spend a few minutes learning how to navigate GEO. Read the tips that are 
listed and click on the blue phrase, “Learn more about how to navigate Google Earth.” You can 
“Sign In” if you have a Google account (e.g., you use Gmail), but it is not necessary. When you 
are ready to move on, close the floating window by clicking the Close button (leave the Show 
Tips at Start-up box checked). You can get the Start-up Tip and other instructions from the Help 
menu at any time. The more complete, though somewhat dated Google Earth User Guide is at: 
http://earth.google.com/intl/ar/userguide/v4/index.htm . In addition you can always Google for 
help with any questions you may have—there are lots of training videos and user advice on how 
to make the most of GEO. 
 
There are reference notes at the end of these instructions that identify GEO’s primary tools. 
Refer to these notes to understand the GEO terms used here. 
 
In the Places Panel in upper left side of the GEO window there is a folder named HHH_Opt_1 
that has all the 3D information. Select (highlight) HHH_Opt_1. In the File menu, put the cursor 
over Save and then select Save to My Places. Now when you start GEO next time HHH_Opt_1 
will already be installed. Do not click on the KMZ file again or it will be loaded twice. To remove 
HHH_Opt_1 from GEO, right click on it and select Delete.  

 

Click on the greater than symbol (>) to see its contents.  

• The HHH IDs are the turbine numbers shown in the Option 1 layout. Click on the greater 
than symbols to open the folders. The labels are Placemarks that have been color coded 
to reflect the impact on the PDF map: green for lowest impact, red for highest impact, 
yellow for impact to one resource and pink for impact to 2 resources. All the labels are 
turned on, but you can turn them off by clicking on the blue check box.  

• The KOPs are the viewpoints used in the visual impact assessment. Double click on one 
to take you to an aerial view above the viewpoint. Position you mouse over a location 
and use the mouse’s scroll wheel to move down to the ground. 

• Then there are four folders for the Impact Classes that contain the turbines. You can 
turn a whole impact class of turbines off or on by clicking on the blue box. If you open an 
impact class folder, the individual turbines are shown using the old ID numbers. You can 
turn individual turbines on and off too. 

If you click on an individual turbine in the map or HHH IDs, a pop-up window lists the ID, the old 
turbine name, the impact class from the PDF map, and the turbine’s location and height to an 
upright blade tip. 

http://earth.google.com/intl/ar/userguide/v4/index.htm


 

 

 
Now you are ready to explore how the HHH wind turbines might appear from any location in 
the study area. 
 
Step 4: View from Your Street. 
We will start by seeing if the wind turbines will be visible from your home. In the Search panel 
of the Side Bar in the top left of the GEO window, type you home address and click Search. This 
will create a Placemark on the map and bring you to an aerial view of the address at an 
elevation a bit over 3,000 ft above the ground. Next we need to get down to a ground-level 
view. 
 
Take the mouse cursor to the upper right side of the window and click-and-hold on the orange 
Pegman symbol. If the street in front or near your house turns blue, drag and drop Pegman’s 
feet where you want the viewpoint to be. Viola! You are in Street View. At the bottom of the 
window is the date of the photograph, its latitude and longitude and elevation (ignore “eye 
alt”). The eye-level of all Street View photos is approximately 10 ft (3 m) or a bit higher than 
normal eye-level. 
 
[There are alternate ways to get to a Ground View. You could simply click near the Placemark; 
keep clicking but not too fast, until you are at Ground View. Or you could hold the 
cursor/crosshairs over the location you want for a viewpoint and use the mouse scroll-wheel to 
get down to ground-level.] 
 
Change to Terrain View by clicking on the building icon at the top of the Navigation Tools. Use 
the Look Around tool’s left or right arrows to pan around the view while staying in place. (Do 
not use the up and down arrows or the Move Around tool yet.) Do you see any turbines? Pan 
until the largest turbine is in the center of the screen where it will be in proper scale.  
 
If you do not see turbines, finish reading the instructions for this step and then go to the next 
step. 
 
Expand the window to full screen size. Notice that the view stays the same—it is just larger. The 
view always defaults to approximately a 90º angle of view in both Terrain and Street View. The 
appropriate viewing distance for this view is half of its width, which is really close. If your eyes 
are that distance from the screen, the turbines will be appropriately scaled. Do not use the 
Zoom Tool because it changes the angle of view and then the appropriate viewing distance will 
be unknown. 
 
Now move the mouse cursor to the upper right corner of the screen and switch back to Street 
View by clicking on the blueish Pegman icon. Check that the horizon in Street View matches the 



horizon in Terrain View by switching back and forth. As you switch back and forth, note whether 
the vegetation and buildings in Street View would screen the turbines visible in Terrain View. 
 
While not perfect, this gives you a good sense of whether the turbines will be visible from this 
particular viewpoint. 
 
Step 5: Moving Around to See Turbines. 
The next question is how extensive are view of the turbine in your neighborhood. Use the Look 
Around tool to face a direction you want to move—or click-and-hold and swipe sideways to 
rotate the view. Move forward Street View by clicking on the forward or backward arrows, or to 
move forward faster, double-click on a location further down the road. Be patient—using mouse 
clicks to navigate can be finnicky. If double-clicking does not work, use the mouse scroll-wheel. 
 
In Terrain View you can move off the road (but there likely will not be corresponding Street View 
photos off the road). Rotate the view to the direction you want to go (the Move Around tool will 
show where north is relative to the direction you are facing). Then move straight forward using 
the scroll-wheel, or double-click on a location you want to move toward. 
 
If you stay on the road, switching back and forth between the Terrain and Street Views gives you 
some idea of how often the turbines will be screened or not.  
 
Step 6: View Settings to Improve the Visual Contrast. 
Sometimes it may be difficult to see the turbines with GEO’s default settings, which do not 
include the variable effects of sun lighting. GEO can simulate sunlight for a specific time of day. 
When the turbines are front lit they will appear lighter, when they are backlit they will be 
darker. In the Tool Bar click on the Show Sunlight icon of the rising sun. It brings up a slider that 
controls the sun’s angle for the time of day.  
 
Another adjustment changes the sky to be lighter and more vibrant. In Windows, open the GEO 
Options in the Tools menu (In Mac, open Preferences in the Google Earth Pro menu) and check 
Photorealistic Atmosphere Rendering in the 3D View tab. 
 
Step 7: Saving a Viewpoint. 
If you have found a view that you want to save so you can come pack to it, you can do that in 
Terrain View. First use the Look Around tool to put the most prominent turbine in the center of 
the image and the horizon in the middle of the image. Then click on the Add Placemark tool (it 
looks like a yellow pushpin) in the Tool Bar. This brings up a window: type in the viewpoint 
name, and make sure that the Altitude is Clamped to Ground. Then click OK. It should be saved 
under My Places in the Places panel, though it may be somewhere else in the Places panel. 
 
Now you can always get back to that view. Click the Exit ground-level view button in the upper 
right corner of the window (if it is not visible, just move around the view a bit). The Placemark 
become visible from an elevated view. Either double-click on the Placemark in MyPlaces, or 
double-click at the base of the Placemark to retrieve the view. 



 
You can save a view as a .jpg file. In the File menu, select Save, then Save Image. Select Map 
Options to control the information displayed with the view. Click in the Untitled Map box to title 
the image. In the upper left corner is the Legend, and you can turn features that may be in the 
view on or off. Adjust the image resolution—the higher the better, though it means a larger file. 
Then click Save Image. 
 
Step 8: Identifying Individual Turbines 
If you are going to submit comments to the EFSEC, then you may want to include images of a 
particular view. It may be useful to refer to the individual turbines on the Option 1 map that 
concern you in the view. This is the primary reason for including the HHH IDs in the KMZ. 
 
The HHH IDs may not always show in Terrain View. If you click and drag the Terrain View 
downward, they may appear. You can also click Exit Ground-level View, but then you need to 
keep track of which turbine interested you.  
 
Step 9: Evaluation of Google Earth Pro Visualizations 
Widely distributing a GEO KMZ is a new approach to help a community understand how a 
proposed wind farm may change the landscape. We invite you to take a short 10 minute survey 
to help us learn about whether it was helpful or not. Your participation is completely voluntary 
and you may decline to answer any of the questions or stop at any time. Your responses are 
completely anonymous. 
 
If you agree to participate in the evaluation survey, click on the link below to be taken to a 
Google Forms questionnaire. 
 
https://docs.google.com/forms/d/e/1FAIpQLSc1i3RV8JxWOq-
q4jG5nXFmh9hk8ueVsnCIrbe3CHBlqp-ong/viewform?usp=sharing 
 
 
We appreciate your participation in this evaluation of Google Earth Pro as a visual impact 
visualization too. 
 
Dean Apostol  James Palmer, Emeritus Professor 
Scenic Expert for Tri-Cities C.A.R.E.S. SUNY College of Environmental Science & Forestry 
dean.apostol@gmail.com palmer.jf@gmail.com 
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Google Earth Pro Reference Notes 
 
Introduction 
These notes locate the basic tools needed to get around in Google Earth Pro. I am using a Mac, 
so the images may be slightly different on a PC. The somewhat out of date Google Earth User 
Guide is at: http://earth.google.com/intl/ar/userguide/v4/index.htm . 
 
Home Screen 
Then you double-click on HHH_Turbines&KOPs_FINAL.kmz, you will see a scree something like 
that shown below.  
 
 

 
The Side Bar includes three panels which are collapsed or expanded by clicking on the triangle 
or caret mark.  

• Search. Locate your home or any place in the world. 

• Places. This is where Placemarks are kept. The KMZ has Placemarks for the turbines and 
the visual impact assessment photosimulation viewpoints. 

 

Side Bar 

 

Navigation 
Tools 

 

Tool Bar 

 

Status Bar 

http://earth.google.com/intl/ar/userguide/v4/index.htm


• Layers. This panel contains various map features, such as roads, terrain, boundaries and 
names. 

 
The Tool Bar includes many useful tools, such as a Ruler for measurements, Sun to adjust the 
direction of sunlight, or creating features as a Placemark, Polygon or Path. Placing the mouse 
cursor over a tool reveals its purpose. 
 
The Status Bar provides the date of the image, the Latitude/Longitude coordinates, and the 
ground and viewer elevation. 
 
Navigation Tools for Earth or Map View. 
 

• Look Around. This moves the map or view around the viewer. Clicking 
the left and right arrows rotates the view; the up and down arrows 
change the tilt of the view. Click and hold on the N to move it around to 
set the direction of north.  

 

• Move Around. This moves the viewer around in the map. 
 

• Pegman. The changes the screen to Street View (and Terrain View). 
Click and drag Pegman onto the map and the screen changes to Terrain 
View (make sure that Terrain is checked in the Layers panel). When 
Pegman is placed on a blue road, the screen changes to Street View.  

 

• Zoom. Moves the view closer or further away. 
 
 
 
 
Navigation Tools for Ground View. 

• Ground View. Allows you to select Pegman’s Street View (if 
available) or Terrain View, and to exit back to Earth View. 

• Look Around. This moves the map or view around the viewer. 
Clicking the left and right arrows rotates the view; the up and 
down arrows change the tilt of the view. Click and hold on the 
N to move it around to set the direction of north.  

• Move Around. This moves the viewer around in the map. 
 
 

• Zoom. Moves the view closer or further away. 
 


